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About QuickView

The Tap In Management Service is the core product in the Tap In Systems product suite and provides
monitoring and control over a variety of networks, systems and applications. This service is an Amazon Web
Services server instance that contains the programming extensions for mediator and consumer scripts. It also
arbitrates communications among the various components using a defined IP socket protocol. Automation,
correlation and client applications use this protocol to share event information. Mediators and consumer
automation applications can run on the same platform as the management server or on remote systems, like
Tap In agents. A management server can support connections to other management servers or Tap In clients.

QuickView is a client of the Tap In Management Server and is a high performance console that enables viewing
of all open events on your management server. QuickView dynamically updates alarms as the management
server processes events. It shows alarm information in a color-coded, text format. Alarms may be filtered and
sorted according to operator requirements. QuickView is a Java based application and runs on any platform
that supports Java, including most Windows, Linux, UNIX, or SUN operating systems.

Figure: Tap In Systems - QuickView Console Application
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Installing QuickView

The QuickView program operates with one Tap In Management Server at a time. However, you may have
multiple instances of QuickView running, each connected to a different Tap In Management Server.

Prerequisites

 Operating Systems - QuickView is a Java client application typically installed on Windows or Linux
systems.

 Java - QuickView is a Java client application and requires the installation of Java version 1.6 or later.

 Tap In Management Server - QuickView requires access to a running Tap In Management Server with a
valid server log in. Refer to the Tap In Systems Administrator Guide for information regarding defining
QuickView users on the Management Server.

Download and Install Java

 Go to the Java site at http://www.java.com/en/download/manual.jsp to download and install Java for the
appropriate operating system.

Download and Install QuickView

Follow the steps below to download and install QuickView for Windows or Linux:

Windows

1. Download - Open a browser to Tap In's web site at http://www.tapinsystems.com/ navigate to the
Resources, Downloads page and select the QuickView Console for Windowns download link.

2. Install – Windows packages are delivered as MSI files. Click the downloaded .msi file, you will be
prompted through the install process.

Linux

3. Download - Open a browser to Tap In's web site at http://www.tapinsystems.com/ navigate to the
Resources, Downloads page and select the QuickView Console for Linux download link.

4. Install – Linux packages are delivered as tar files. Untar the downloaded .tar file.

Figure: Tap In Systems - Downloads
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Launching QuickView

Follow the instruction below to launch QuickView for Windows or Linux:

 Windows - Click on the Tap In QuickView icon  that was placed on your desktop after
installation.

 Linux – Call the Java program directly using the command below. Make sure that you issue the
command from the same directory ast he jar files. Note also that the configuration XML file is referenced
as the last parameter. If you wish to use a different configuration file, you will need to modify the file
name referenced in this command line.

start javaw -classpath .\WmiProxy.jar;.\axis.jar;.\jaxrpc.jar;.\js.jar;.\jdom.jar;.\hsqldb.jar;.\servlet-
api.jar;.\spark-1.2.jar com.spiderweb.quickview.Gui qvdefault_default.xml

QuickView Login Dialog

After launching QuickView a login dialog box will be displayed. Enter the following settings, click OK and
QuickView will startup and connect to the Tap In Management Server. If the connection to the Tap In
Management Server fails, you will see an error message dialog box. Usually this means the server is not
running on the machine you specified, or you are using an invalid host name, username or password.

 Conf file - This is the configuration file containing the parameters for the session you are opening. Select
Browse to navigate to the Conf subdirectory and select the qv_default.xml file. Once you are familiar with
QuickView you can edit this file to set your own default session parameters; see Automating QuickView
Startup in this document.

 Host - This is the management server. Enter the host name of the management server that you started
(e.g. test6.tapinsystems.net).

 Username and Password - Enter the username and password that you defined as a Consumer user in
the Management Server setup process. If you did not change these settings, you can use the default
values peter and peter.

Figure: QuickView Login Dialog Box

Stopping QuickView

To stop the QuickView application, select File, Logout from the menu bar, or close the QuickView window by
clicking the “X” in the top right corner of the application window.
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QuickView Operations

QuickView Main Window

Once launched, the QuickView program creates a window and displays events from the Tap In Management
Server to which you are connected. A typical QuickView console view is shown below.

Figure: QuickView Console Main Window

Title Bar

The title bar shows whether a SSL connection is used, the username and the Tap In Management Server
host name.

Menu Bar and Action Bar

The menu bar and action tool bar are positioned on the top of the window.

Event List and Scrolling

The event list displays all open events. Each event in the QuickView console is displayed horizontally
across the screen. Each event has multiple attributes. The attributes form the columns on the console
window. The initial console fields displayed and the order that they appear are defined in the configuration
XML. You can scroll up and down or right and left using the scroll bars on the bottom and right edges of
the window.

Column Sorting, Width, and Position

Columns in the event display can be sorted (ascending or descending) by clicking the column titles. To
change the width of a field, drag the line separating the field. You can also change the order of the fields
by dragging and placing the field in desired order.

 Event Summary and Filter Name

A summary display on the bottom of the window shows the total number of events by severity. This area
also lists an event filter name if one is being used.
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Scrolling, Sorting, and Selecting Events

 Scrolling - Typically there is more information in the QuickView window than can be displayed on the
screen. To view all attributes of an event, use the horizontal scroll bar. To view other events not
displayed within the window, use the vertical scroll bar.

 Sorting - Sort by any event field by left clicking on the field name in the header row.

 Selecting Events - Users can take action on events by first selecting one or more events, then selecting
an action. Selected event(s) will turn gray, and the window will be frozen. Select specific events by:
Clicking on an event, Dragging over multiple events, or Clicking on an event, pressing CTL and selecting
additional events.

QuickView Action Bar

Action Description

Select/Deselect All Events - If no alarms are selected, this will select all events in the QuickView
window and freeze the window. If alarms are selected, this will un-select all alarms.

Close Selected Events - This will clear this event from the active event list and the event(s) will be
cleared for all other QuickView users and consumer applications.

Accept Ownership of an Event - This indicates the selected event is “owned” by a user. This
feature allows multiple users to identify which problems are under investigation and which are not.
After selecting an event and selecting Assign, the user's ID in placed is this field.

Route To - Route event ownership to another user. After selecting an event and selecting Route
To, a list of users (consumers) is displayed. Selecting one of these users will place that user's ID in
the Route To field and that user can see events routed to him. A user can then indicate
acceptance of an event by selecting Assign whereby the Route To field will then be cleared.

Resume Display - When this icon is selected updates to the console are enabled. Blinks when
Stop icon is selected. The QuickView window is either in an “active” (resumed) state or “frozen”
(stopped) state. When in active state, new events processed by the Tap In Management Server
automatically update the event window. However the QuickView user may wish to freeze the
window, preventing automatic updates, in order to examine events.

Stop Display - Selecting the Stop option from the menu or action bar can do this. If the window is
in frozen state, the Stop action icon will flash. Clicking the Resume icon will put the window back
into active state, any queued events will update the window, and the icon will no longer flash.

Resync - This forces a fresh set of active events to be sent by the Tap In Management Server to
QuickView. Normally only new events are sent to QuickView. This option replaces the open event
list in QuickView with the current copy from the server. If the view on the QuickView becomes
corrupted for any reason, simply choose the File/Refresh menu selection and the display will be
redrawn for you.

Inspect - See all the details of a single event by double-clicking the event. If you select multiple
events and then select the Inspect icon, the next/back buttons ( “>>>” and “<<<”) will be active,
allowing you to page to the next or previous event. You may also use this dialog box to copy and
paste field values into other applications or documents.

Set an SQL filter - Define filters that can be applied to the console event list. See Defining a
Console Filter below for detailed steps.
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QuickView Menu Bar

Various actions can also be accessed from the QuickView menu bar. Below lists other actions that are only
accessible for the menu bar.

Option Description

File>Login Login - This option is only active if you are logged out. This option displays the Login in
dialog box.

File>Logout Logout - Only active if you are logged in. This will disconnect QuickView from the Tap In
Management Server but keep QuickView active. You can then log in to another Tap In
Management Server. Log out by selecting File, Log Out, or just closing the window.

File>Print Print - Accessed from the menu bar. This option allows the event list to be sent to a
printer or saved to a file.

File>Close Close - Accessed from the menu bar. This option closes the QuickView window and
program.

Help Help - Opens a browser to the QuickView help page on Tap In System’s web site.

Help>About About - Opens a window displaying the QuickView version.

Defining a Console Filter

The Filter option allows you to filter the open event list and only show events that match an SQL select
command, for example; show only Severity 1 events.

1. Select the action icon  or choose the Custom>Filter menu option. The Set SQL Fillter dialog box
will be displayed.

2. Select the “+” sign next to Builder to create a valid SQL statement.

3. Individulally click in the cells above the “+” and select the filter criteria from the drop-down lists. For
example:  Field: SEVERITY, Operator: “=”, and the Severity to match is “1”. You can also type the SQL
condition directly into the Filter section if you know the field names and conditions.

To create multiple conditions, select the Builder “+” sign again. The AND or OR operators can be used
to build complex SQL conditions. The full SQL syntax is supported, including LIKE and IN operators.

4. Once the SQL condition is defined, select Copy to fill out the Filter area.

Figure: Set SQL Filter Diaglog Box
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5. Next, select Apply and the event window will only show those alarms that match the Filter condition
that was set. The filter details are shown at the bottom of the event window.

Figure: Filtered Results

6. Once you create an SQL definition, you can select Save and recall the saved filter another time. To use
a saved filter, open this dialog box, select Browse and select your saved filter file.

Figure: Opening a Saved Filter
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Configuring QuickView Default Settings

Configuration XML

QuickView uses a configuration file to set the connection and display parameters. You can configure your
default QuickView settings by editing this configuration XML file.

Sample settings and descriptions for qv_default.xml:

<QUICKVIEW
debug="none" # Setting ON displays additional messages to the console.
Host="" # Hostname of the Tap In Management Server
username="" # Username defined on the Tap In Management Server
password="" # Username's password defined on the server
sev1color="255" # Override the display color settings for severities.
Sev2color="32767" # Can be specified as decimal or hex if preceded by numbers.
sev3color="65535" # Are justified left. Example:“255”,“#FF”, and “#FF0000” all
sev4color="16776960" # represent the color red.
sev5color="597">
<SSL keyStore="C:\\tapinsystems\\spider.bin" # If SSL option is used, this is the location of the 

keyStorePassword="spideradmin"/> # SSL certificate. If SSL is not used, delete this line.
    <LOG stdout="C:/stdout.txt" # Log file output files.

stderr="c:/stdout.txt"/>
<COLUMNS> # Define the event columns to display, order and width.

<ID width="80"/> # ID - The event’s unique identifier
<ASTO width="0"/> # Assigned To – ID of the consumer accepting ownership
<RTTO width="0"/> # Route To – ID of the consumer event routed to
<SEVERITY width="80"/> # Severity – The severity of an event
<PRIORITY width="80"/> # Priority of an event
<COUNT width="80"/> # Count – The number of redundant events
<FIRST width="120"/> # First Time – Creation time of this event
<LAST width="120"/> # Last Time – Last time this event was updated
<CLASS width="100"/> # Class – A class designation assigned by the server
<GROUPING width="200"/> # Group – A group designation assigned by the server
<EMS width="80"/> # EMS – The category of the event
<RULE width="100"/> # Rule – The rule name generating an event
<T1 width="0"/> # T1/N1-T3/N3 – Unique identifier for an event based
<N1 width="200"/> # on the HRL fields in the form of T1:N1, T2:N2, T3:N3.
<T2 width="0"/>
<N2 width="150"/>
<T3 width="0"/>
<N3 width="150"/>
<MESSAGE justify="left" width="800"/> # Text message associated with an event
<STAT width="0"/> # Status of the event - assigned, accumulates, times out, etc.
<GA width="0"/> # Graph Attribute – Attribute name associated with an event
<GV width="0"/> # Graph Value – Attribute values associated with an event

</COLUMNS>
<SPARKLINE type="line" title="SEV1" limit="60"> # Define the event-input-rate graph displayed on the bottom
</SPARKLINE> # of the QuickView window.
<SPARKLINE type="line" title="SEV2" limit="60"> # Valid types are line and bar.
<SPARKLINE type="line" title="SEV3" limit="60">. # Limit shows the last number of incoming events to include
</SPARKLINE> # in the graph.
</SPARKLINE>
<SPARKLINE type="line" title="SEV4" limit="60">
</SPARKLINE>
<SPARKLINE type="line" title="SEV5" limit="60">
</SPARKLINE>

</QUICKVIEW>
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Automating QuickView Startup

You can automatically connect to QuickView and a Tap In Management Server with a single click. This
automation process launches the console while bypassing the Login dialog box that normally prompts you for
host information and login credentials. This process includes a command (or a Windows batch file) that
includes reference to the defined host, username, and password settings defined in the configuration .xml file
and connects to the defined host. Follow the steps below to edit your configuration file and launch QuickView.

If you wish to enter these settings manually upon startup, you can leave your configuration file settings blank
and enter them in the login dialog box. Entering these parameters in the dialog box will override the
configuration file settings; host, username and password.

1. First you need to have the host, username, and password settings defined in your configuration .xml
file.

<QUICKVIEW
debug="none"
host="testebs.tapinsystems.net" # Hostname of the Tap In Management Server
username="peter" # Username defined on the Tap In Management Server
password="peter" # Username's password defined on the Tap In Management Server

2. Next, you can open a command prompt window and execute the folllowing command (on a single line
with quotes). Or for convienence you may want to create a batch file  with the following command and
place a short cut to the batch file on your desktop.

“C:\Program Files\Tap In Systems\QuickView\quickview.exe” “C:\Program Files\Tap In
Systems\QuickView\conf\qv_default.xml”

3. Entering the command line or execting a batch file will open QuickView to the host specified in your
configuration file (e.g. qv_default.xml).
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Glossary

This section defines terms relating to the Tap In QuickView application.

QuickView A Tap In software application that converts Tap In Management Server data into
a human-readable display of color-coded monitoring events.

Tap In Management
Server

Tab In software that runs in the Amazon Web Service (AWS) cloud as an Elastic
Compute Cloud (EC2) instance, and converts events from systems and other
technology components into a neutral format stream of events for use by
consumer programs.

Mediator A program that monitors status of a device or system and sends events to the
Tap In Management Server.

Consumer A program that uses Tap In Management Server events for special purpose
management functions. QuickView is a consumer program.

Event A discrete piece of information describing a real-world situation, as described by
the Tap In Management Server system and displayed by QuickView. An event
has identifying attributes such as a severity, priority, text message, and ID
number. Event is used interchangeably with the term “alarm”.

Open and Closed Events Events that are open represent current problems in the managed environment.
QuickView only shows open events as events that are closed do not represent
current problems or are not of interested to operators. An operator can use
QuickView to close an open event. Closed events are logged in the Tap In
Management Server database.

Event Display The main window of the QuickView application that displays Tap In Management
Server events in detailed. The events are presented in a line-by-line format.

Filter A Structured Query Language (SQL) specification used to screen alarms before
being displayed to the user. SQL statements can be defined and saved by the
QuickView user, then applied to the current event display.

Alarm A discrete piece of information describing a real-world situation, as described by
the Tap In Management Server system and displayed by QuickView. An alarm
has identifying attributes such as a severity, priority, text message, and ID
number. Alarm is used interchangeably with the term “event”.

Perl An interpreted language, optimized for scanning and extracting information for
use in management systems. Most mediators are constructed using Perl scripts.

Attributes: Discrete attributes or elements that comprise each Tap In Management Server
event:

     EMS Element Management System - This field indicates the source of the alarm, and
is set by the Tap In Management Server to its host name.

     CLASS A user-definable class designation typically set to the category of managed
devices. For example, all events from the Linux Agent may have a class
designation of “Linux_Agent”.

     GROUP A user-definable group, typically defining a common field across different
classes. For example, events from different managed devices that affect a
specific application may have the same group setting.

     RULE The rule name generating an event designating the type of alarm. For example,
for in the Linux Agent class, an event showing available memory space might
have a rule called “free_memory”.

     HRL Hierarchical Resource List - A series of name-value string pairs, T1 through T3,
and N1 through N3. These fields represent the origin of an alarm. Each level
contains a type field and a name field. For each event, the HRL indicates the
affected component as specifically as possible. For example, if an event is
received from a network component that affects a specific a card and port, the
HRL might look like the following:
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contains a type field and a name field. For each event, the HRL indicates the
affected component as specifically as possible. For example, if an event is
received from a network component that affects a specific a card and port, the
HRL might look like the following:

T1 – Host

N1 – 192.168.1.200

T2 – Card

N2 – A

T1 – Port

N1 – 101

     COUNT The number of redundant events with the same class, rule and HRL. The
mediator determines whether an alarm will increment this count when redundant
alarms appear, or whether a new alarm will be generated.

     SEVERITY The severity of this event, ranging from 1 (highest) to 5 (lowest). The color of the
alarm indicates its severity. The default colors are red (severity 1), orange
(severity 2), yellow (severity 3), cyan (severity 4) and green (severity 5).

     PRIORITY The priority of this event, ranges from 1 to 99.

     FIRST TIME The first time an event was viewed.

     LAST TIME The last time an event was viewed for redundant events.

     EVENT ID The unique identifier of an event.

     ASTO A consumer name assigned to this event.

     RTTO A consumer name to which an event is to be routed (not yet accepted).

     STATUS The status of the event. Can be a combination of single character designations
used to indicate how the management server will process the event.

     TEXT The textual message associated with this event.

     GA A graph attribute that is interpreted by the reporting program as an item to be
graphed

     GV A graph value that is interpreted by the reporting program, associated with the
GA, as the value or number to be graphed.


